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What we do at the CCDC

Charitable Objective:  Advancement 
of chemistry and crystallography for 
the public benefit through providing 
high quality information services 
and software

International 
repository of 3D 

curated structures

Collaborative 
research and 

knowledge-based 
services

Scientific software Education and 
Outreach



Structural databases

CSD
>1.1 million 

organic and 
metal-organic

ICDD
Powder 

diffraction 
files

PDB
>190,000

polypeptides, 
nucleotides 

& saccharides

ICSD
>260,000
(no C-H and C-C 

bonds) 

Elements, 
minerals, 

metals



The vision of the CSD

J.D. Bernal and research group including Olga Kennard at Stonehenge in 1948 

• Established in 1965 
by Dr Olga Kennard

• She and J.D. Bernal 
had a vision that a 
collective use of data 
would lead to new 
knowledge and 
generate insights



The vision



The Cambridge Structural Database (CSD)

>1,180,000
Structures 
published 
that year

Structures 
published 
previously

• Every published structure
• Inc. ASAP & early view

• CSD Communications

• Patents

• University repositories

• Thesis

• Every entry enriched and 
annotated by experts

• Discoverability of data 
and knowledge

• Sustainable for over 55 
years

• A trusted CoreTrustSeal 
repository

XOPCAJ - The millionth CSD structure. 

An N-heterocycle 
produced by a 
chalcogen-bonding 
catalyst. Determined 
by Yao Wang and his 
team. 



Inside the Cambridge Structural Database

Metal-Organic
• Metal Organic Frameworks
• Models for new catalysts
• Porous frameworks for gas storage
• Fundamental chemical bonding

Organic
• Drugs
• Agrochemicals
• Pigments
• Explosives
• Protein ligands

Not Polymeric
89%

P
o

lym
eric: 11%

Organic
43%

Metal-Organic
57%

At least one transition metal, 
lanthanide, actinide or any of Al, 

Ga, In, Tl, Ge, Sn, Pb, Sb, Bi, Po

Single 
Component

56%

Multi 
Component

44%

ligands

ligands

Links and subsets 
• DrugBank
• Druglike 
• MOFs
• PDB ligands
• PubChem
• ChemSpider
• Pesticide PDB

Additional data
• 11,525 polymorph families
• 171,683 melting points
• 909,992 crystal colours
• 778,663 crystal shapes
• 24,916 bioactivity details
• 11,387 natural source data
• > 250,000 oxidation states

The CSD is a database of all the published organic and metal-organic experimental crystal structures



Exploring the CSD

• > 1 million structures
• >94M 3D coordinates

• > 28 million bond lengths
• >2M unique distributions

• > 40 million valence angles
• >3M unique distributions

• > 14 million torsion angles
• >800K unique distributions

• > 2 million rings
• >400K unique distributions

Images and graphics created using the CSD Python API and Flourish



A trusted and linked repository

Wilkinson, M. D. et al. The FAIR Guiding Principles for scientific data management and 
stewardship. Sci. Data 3:160018 DOI: 10.1038/sdata.2016.18 (2016)

ORCID iDs for 
Researchers

DOIs for 
Digital 
Objects

InChIs for 
Chemical 
Structures

DATA SHOULD BE

BY HUMANS AND MACHINES

Interoperable
Reusable

Findable
Accessible



From experiment to knowledge

Experiment

Knowledge



About you

Have you done any of the following before?
• Searched the CSD using ConQuest
• Searched the CSD using Access Structures or WebCSD
• Visualised or explored crystal structures with Mercury
• Collected and / or refined your own crystal structure
• Deposited a structure with the CCDC

Raise your hand up if you have



Deposition

• Data deposited pre-publication 
• Enables links to data sets at the 

point of publication
• Tailored deposition service

Countries contributing data



Deposition workflow

• Our deposition service aims to 
make it easy for you to:
• Follow community 

recommendations

• Provide reliable data and 
metadata

• Deposit all organic, inorganic and 
metal-organic data

Login Upload Check 
Syntax Validation Add 

Publication
Enhance 

Data Review

• Components include:

• Identification of contributors

• Use of standard formats & syntax checking

• Generation of validation report

• Capture of publication, experimental and 
chemical metadata

• Additional enrichment of data by CCDC or FIZ

• Ability to publish directly in the CSD or ICSD



Deposition

Level A
Most likely a serious problem,
resolve or explain

Level B
A potentially serious problem,
consider carefully

Level C
Check. Ensure it is not caused 
by an omission or oversight

Level G
General information/check it is 
not something unexpected

CheckCIF Responses:



CSD Communications

https://www.ccdc.cam.ac.uk/Community/csd-communications/

Small molecule crystal structure data published just through the Cambridge 
Structural Database without a journal article



Once deposited your data is curated

I.J.Bruno, G.P.Shields, R.Taylor, Acta Cryst. (2011). B67, 333-349 DOI: 10.1107/S0108768111024608

An automated probabilistic 
approach using data in the CSD

Chemistry 
assignment makes 

data findable, 
interoperable and 

reusable 



Using experts to ensure quality

• Each entry looked at by expert Scientific Editors
• Automation focuses editorial efforts
• Manual validation of automated chemical 

interpretations improves automated methods

https://www.ccdc.cam.ac.uk/Community/blog/CSD-data-curation-the-human-touch/



www.ccdc.cam.ac.uk/structuresAccess Structures

• Access Structures allows you to search CSD and ICSD
• Every individual dataset is free to view and download



Finding structures

ConQuest

DesktopWeb Browser

Access Structures / 
WebCSD 

Programmatic

CSD Python API



Targeted collections

• Easy access to the most 
relevant structures

• Benefit from our in-house 
and external expertise

• Convenient starting point for 
analysis using CSD or 3rd

party tools
• A basis for your research and 

crystal engineering High 
Pressure

Hydrates

Polymorphs Electron 
Diffraction 

Teaching
https://www.ccdc.cam.ac.uk/Community/blog/how-to-use-the-new-
electron-diffraction-polymorphs-hydrates-and-high-pressure-CSD-
subsets/

Best 
representative

ADPs MOFs Drugs

Pesticides COVID-19



Visualising and exploring structures

Full Mercury

AdvancedThe basics

Free Mercury

Macromolecules

Hermes



Why use Mercury to visualise structures?

We can use Mercury to explore over 1.1 million structures 
• It is designed for visualisation and analysis of crystal structures – ad 

hoc set of styles, colours and features.
• To gain new insights on your structures using knowledge in the CSD
• To create high-resolution images, high-resolution videos, and 3D print 

files for publications, presentations, reports, thesis and videos

Find out more 
in the CSD 

session today



Analysing structures

Isostar and FIMs

InteractionsGeometries

Mogul

Advanced

CSD Materials

hydrogen-
bond donor

hydrogen-
bond acceptor

hydrophobic 
interactions

Find out more 
in the CSD 

session today



Why analyse structural data? 

• To explore over 1.1 million structures and see 
in 3D how molecules pack and the different 
intermolecular interactions inside the 
structures

• By understanding intermolecular interactions 
and crystal packing it can help us to design 
new solids with desired physical and 
chemical properties
• This is known as crystal engineering

• This can be particularly helpful when 
exploring different polymorphic forms and 
can help us to better understand crystal 
stability



The CSD software



The CCDC Portfolio

• The CSD is at the heart of the CCDC Portfolio and provides the 
accurate structural data from which key insights can be extracted.

https://pubs.acs.org/doi/abs/10.1021/acs.chemrev.9b00155

CSD

Geometry

Interactions

Packing

• Over 1 million crystal structures.
• Many millions of geometric 

parameters.
• Many millions of interactions.
• Over 10,000 polymorph families.

https://pubs.acs.org/doi/abs/10.1021/acs.chemrev.9b00155


CSD-Community - CellCheckCSD

• Freely available through CSD-Community
• An automated tool for checking unit cells 

against the CSD during data collection
• Used to:

• Match existing cell dimensions

• Check sample is novel

• Check crystal is not starting material or a by-
product

• Ensure diffractometer time used effectively

• Usually downloaded from instrument 
manufacturer



EnCIFer – CIF syntax checker
• Enables validation and preparation of CIFs 

for deposition with journals & databases
• Allows CIF editing without corrupting 

syntax
• Data entry wizards enables addition of:

• Publication details
• chemical, physical & crystallographic 

properties
• Visualises structures in a CIF
• Links to CCDC Deposition

http://www.ccdc.cam.ac.uk/free_services/encifer/ 



CSD-Core overview

CSD-Editor: Create
in-house database

Cambridge Structural 

Database

ConQuest: Advanced 3D 
searching & data generation

WebCSD: Online search & 
entry level interface

Mogul: Molecular
geometry analysis

IsoStar: Intermolecular
interaction analysis

CSD Python API: Access to 
data & all functionality

Mercury: Visualisation
& numerical analysis

Hermes: Visualisation of 
macromolecules



Mogul: Molecular geometry

Mogul:
• Mines millions of chemically classified bond lengths, angles, torsion 

angles and ring conformations in the CSD.
• Provides precise information on favourable molecular geometries.
• Runs in a few to ten seconds.
• Used by wwPDB for ligand validation.

Applications: 
o Validation of:

o molecular geometries.
o docking solution.

o Generation of low energy conformations.
o Selection of linking groups.
o Rationalisation of inactivity.

Bruno I., et al. J. Chem. Inf. Comput. Sci. 2004, 44, 2133-2144. DOI: 10.1021/ci049780b

Find out more 
in the CSD 

session today

https://doi.org/10.1021/ci049780b


IsoStar: Intermolecular interactions

I. J. Bruno, et al. J. Comput.-Aided Mol. Des.1997, 11, 525-537. DOI: 10.1023/A:1007934413448. 

Isostar:

• Experimental data from CSD and PDB protein-ligand complexes

• Interaction distributions displayed as scatterplots or contour surfaces

• Knowledge base used to generate Full Interaction Maps

Applications: 

o How do particular groups typically interact in structures in the CSD? 
(e.g. do hydrogen-bonds to ether oxygen lie alone lone pairs?)

o How do particular ligand groups interact with particular protein residues? 
(e.g. from a drug design perspective, how can we bind to a tryptophan?)

o What particular group can be a bioisostere for another particular group?
(e.g. do thiazole and oxazole form similar H-bond interactions?)

Find out more 
in the CSD 

session today

https://doi.org/10.1023/A:1007934413448.


https://sharpahead.com/

CSD-Materials Overview

CSD-Materials

Full Interaction Maps: discover preferred 
intra- and inter- molecular interactions.

Hydrate Analyser: understand 
the effects of hydration on 

your solid form.

Conformer Generator: explore 
molecular geometry with 
validation from the CSD.

Crystal Packing: packing feature, 
similarity and motif searches and 

H-bond propensity analysis.

CSD Python API: Access to 
data & all functionality

Solvate Analyser: explore and 
analyse even complex 

solvates.

Co-crystals: explore potential 
co-formers with molecular 

complementarity

Understand 
your solid form.

Crystal Morphology: calculate 
and display BFDH 

morphologies.
Multi-component screening: based 

on molecular complementarity.

Insights from CSD 
– experimentally 

derived.

Hydrogen Bond Statistics: assess 
how (un)usual observed H-bonds 

are to assess stability



materials informatics 

Data inspired materials design

• Structural knowledge used to inform key decisions.

• Integrated digital workflows to guide development and identify risks.

molecule

solid form

particle

properties

product



CSD-Discovery overview

SuperStar: Analyse, predict and understand protein and 
ligand interactions

GOLD: Protein-ligand docking and virtual screening

Ligand-based virtual screening workflow to find new hits.

CSD-Conformer Generator: Generation of molecular conformations.

CSD-Ligand Overlay: Flexible alignment of ligands.

CSD Python API: Create CSD-driven analyses and workflows.

Script-based interfaces to the Field-Based Ligand Screener; protein 
cavity and sub-pocket search and comparison; protein-ligand 
substructure & interaction pattern mining.

CSD-CrossMiner: Interrogate the CSD and the PDB for 
common interaction patterns

CSD-Discovery.



A wealth of structures, stories and possibilities

CSD one million special issue
• 33 articles from industry and academia

The CSD - A wealth of knowledge gained from a million structures. CrystEngComm, 2020,22, 7131-77502
The CSD. C.R.Groom, I.J.Bruno, M.P.Lightfoot and S.C.Ward, Acta Cryst. (2016). B72, 171-179 DOI: 10.1107/S2052520616003954



CSD Applications
• Teaching
• Drug Design
• Materials Design
• Structure Solution
• Energetic materials
• Paints, Pigments and Dyes
• Organic Semiconductors
• Nonlinear Optical Materials
• Catalysts
• Gas Storage and Separation
• Crystal Engineering

The whole is greater than the sum of its parts

CSD Insights
• Molecular geometries
• Molecular interactions
• Molecular assemblies

https://doi.org/10.1021/acs.chemrev.9b00155



Using the CSD to develop new drugs

• By combining experimental and informatics results, scientists can 
have greater confidence in progressing a solid form in 
development

• CCDC, in having extensively worked with some of our closest 
pharma partners, has seen first-hand the systems in current 
development pipelines and the problems faced on a daily basis

Read in 
CIF

Geometry 
check

H bond pairing / 
coordination

H bond 
propensity

Packing 
analysis

Mean H-Bond Propensity

M
ea

n
 H

-B
o

n
d

 C
o

-o
rd

in
at

io
n

N. Feeder et al., Pharm Pharmacology, 2015, 67, 857-868 DOI: 10.1111/jphp.12394



More to explore…

Teaching & Learning

Software Training

Outreach

www.ccdc.cam.ac.uk/Community/educationalresources/

On-demand 
modules with 

completion 
certificate

YouTube How 
to videosSelf-guided 

workshops

CSD 
session at 

15:30



I think that the great ocean of 
truth is still in front of us and that 
we will continue to discover new 
aspects of this truth.

Dr Olga Kennard, Founder of the CSD

“

”



Ilaria Gimondi

Education and 
Outreach Officer

Suzanna Ward

Head of Data and 
Community

The Cambridge Structural 
Database - Learning from 
one million crystal structures

igimondi@ccdc.cam.ac.uk
ward@ccdc.cam.ac.uk

mailto:igimondi@ccdc.cam.ac.uk
mailto:ward@ccdc.cam.ac.uk


Agenda

• Introduction to the CSD
• Visualizing structures in the CSD

• Slides and follow-along demo

• Analysing the geometry of structures using Mogul
• Slides and follow-on along demo

• Analysing intermolecular interactions using FIMs
• Wrap up, quiz and summary 



Learning outcomes for today

• How to visualise and explore over a million crystal structures
• What the Cambridge Structural Database is and how it can be used in your research
• How to visualise structures using Mercury
• How to explore the packing, symmetry and hydrogen bonded networks of structures

• How to analyse the geometries of structures using Mogul 
• Familiarise yourself with the basics of Mogul
• How to get more insights into your crystal structures and interpret results obtained from 

Mogul
• How to use Mogul for CSD structures and new structure determinations

• How to analyse the interactions within a crystal structure
• Familiarise yourself with how Full Interaction Maps are generated and how to create them
• How to interpret results obtained from FIMs
• Why looking at interactions are important and how FIMs can be used in your research



What is a crystallographic database?

• They usually include:
• Bibliographic data
• Crystallographic, chemical and experimental information
• Atomic coordinates

• What makes a crystallographic data special?
• Standard agreed file format
• Every published structure is added to the appropriate database
• There are established curated databases rather than just collections of data 

with some level of quality control through processing & validation
• They enable you to learn from the wealth of data they contain



What can you do with a database?

• Most importantly, when used effectively you can 
derive structural insight from a database

• They provide insights and context around:
• Cell dimensions and space groups
• Intramolecular geometry & Intermolecular interactions
• Metal coordination geometry
• Supramolecular packing

Insight: “based on all 
the fruit salads 
observed, perhaps 
you shouldn’t put a 
tomato in a fruit 
salad!”

Data: “a 
tomato 
is a fruit”



About you

1. Have you done any of the following before?
• Analysed molecular geometries using Mogul
• Analysed interactions using Full Interaction Maps

2. Do you have the CSD portfolio installed?
• Yes I have the full CSD
• Yes - but I have not activated my license
• Yes - but only the Teaching Subset and free Mercury 
• No



Agenda

• Introduction to the CSD
• Visualizing structures in the CSD

• Slides and follow-along demo

• Analysing the geometry of structures using Mogul
• Slides and follow-on along demo

• Analysing intermolecular interactions using FIMs
• Wrap up, quiz and summary 



The CSD Portfolio



Mercury – Structure visualisation 

With Mercury you can:
• Explore over 1 million crystal 

structures, molecular conformations, 
crystallographic planes and 
simulated morphologies

• Generate high quality structural 
images for effective scientific 
communication

• Output model files for 3D printing
• Analyse geometries, interactions and 

the packing inside structures



The basics of Mercury

AABHTZ



Right mouse click

Near a molecule                                       Away from a molecule



Type in a refcode

Handy tips: 
• Recovering 

Toolbars
• Resetting 

view

v



CSD Refcodes

What is XOPCAJ?
• A CSD Refcode
• A database reference code
• Containing 6-8 characters
• Used to identify entries in the CSD

Refcode families
• The same substances are assigned the same 6 letter code plus an additional 2 numbers

• Polymorphs
• New determinations or re-refinements of the same substance
• Determinations at different temperatures/pressures

• Stereoisomers or different solvates, co-crystals, etc are assigned different refcode families

CSD Refcode -
XOPCAJ

Some of my favourite refcodes are: KITTEN, BATMAN, DISNEY, GAUTAM, GLYCIN



Changing display - Style



AABHTZ

Reset 
button: 
a friend!



Using your own file
• File > Open – to open one of your own files for example a CIF
• Edit > Auto Edit Structure to assign bond types
• File > Auto Edit Structure on Load to automate



Generating high quality images

• File > POV-Ray Image
• Change Resolution

• Width = 4000
• Height = 3000

• Change ‘Material 
Properties’ to 
‘Metallic’

• Set ‘Background’ to 
‘Transparent’

• Press ‘Preview’



From visualization to deeper understanding

By exploring 3D structures, we can gain a deeper understanding of:
• Chemistry

• The geometry of molecules
• The geometry around metals

• Solid forms
• How molecules pack together
• What voids and channels exist within a structure
• What interactions help to stabilise the structure
• How structures including polymorphic structures compare
• The symmetry within a structure and different space groups



Measure distances
CSD Refcode: 
NATJOH



Click on “Default 
definition” to 
change the 

default H-bond 
definition

HXACANVisualising hydrogen bonds



Visualising hydrogen bonds

HXACANLeft click on the 
atoms at the end 

of the dashed lines 
(known as 

hanging contacts) 
to expand the 

network

Right click on 
hanging contacts 

to see more 
advanced options 
including delete 

hanging contacts

Tip - Change H-bond thickness by
Display>Styles>Contact settings…

Tip - Change H-bond colours by
Display>Colours>Contacts…

>colour by distance>All contacts



Graph Sets

Graph Sets describe the
H-bonds pattern.
• M.C.Etter, Acc. Chem. Res., 23, 120, 1990.
• J.Bernstein, R.E.Davis, L..Shimoni, N.-L.

Chang, Angew. Chem. Int. Ed., 34, 1555,
1995.

• W.D.S.Motherwell, G.P.Shields and
F.H.Allen, Acta. Cryst. B56, 466, 2000.

Click through the 
graph set descriptors 
to see the different H-

bond patterns



Empty space visualisation

CSD Refcode: SAHYIK
(MOF5)

Analysing voids helps 
us better understand 
the nature of porous 

materials which can be 
used in sorption, in 

catalysis, separations 
and as sensors.



Exploring symmetry 
CSD Refcode: 
HXACAN



To show or remove 
symmetry  elements 



Follow along Mercury Demo

Visualisation options in Mercury
We will:
• Navigate the interface.
• Apply different styles and colours.
• Visualise packing.
• Visualise symmetry elements.

PORTOG

BARBAD09



Agenda

• Introduction to the CSD
• Visualizing structures in the CSD

• Slides and follow-along demo

• Analysing the geometry of structures using Mogul
• Slides and follow-on along demo

• Analysing intermolecular interactions using FIMs
• Wrap up, quiz and summary 



Why analyse structural data? 

• We can use Mercury to explore over 1.1 million structures and see in 3D 
how molecules pack together and the different intermolecular 
interactions inside the structures

• By understanding intermolecular interactions and crystal packing it can 
help us to design new solids with desired physical and chemical 
properties
➢Crystal engineering

• This can be particularly helpful when exploring different polymorphic 
forms and can help us to better understand crystal stability



A solid form landscape
Polymorphs

SolvatesHydrates

Salts
Co-crystals

IVUQOF IVUQOF02

IVUQIZ

UPOQAS

IVUQEV

UPOQEW

fluconazole



Exploring contacts and exploring chocolate

• Hydrogen bonds and short contacts can help to stabilise a crystal 
structure

• Different polymorphs with different bonding networks often 
exhibit different properties



A real-life example…..

Bauer et al. Pharm. Res., (2001) 859, DOI:10.1039/B910882C

Different 
interactions

Different solubility
Different stability

Can structural knowledge mitigate risk?



Great 
Wall 
of China
c.1368

A B

Structural Informatics
Which is the stable wall? Belém

Tower
c. 1514

Águas Livres 
Aqueduct c.1731 

Carmo
convent 
c. 1389

Castelo 
de São 
Jorge



Great 
Wall 
of China
c.1368

A B

Structural Informatics
Which is the stable wall?

The database of walls indicates that 
A is the frequently observed 
arrangement and therefore we can 
predict it is the most stable form

Great 
Pyramid 
of Giza
c.2560 BC

Hadrian’s Wall
c.122 

The 
CCDC
c.1992

My 
House
c.1967

Great 
Wall 
of China
c.1368



Predicting unlikely interactions

Galek et al, CrystEngComm, (2009), 11, 2634 - 2639

Predictive analytics is used to identify the likelihood of specific molecular interactions 
occurring from similar crystal structures

32%
22%

42%

11%Form I
Form II



The CSD software



Characteristics that influence stability

Molecular
Conformation

Hydrogen Bond
Donor/Acceptor Pairing

Hydrogen Bond
Geometry, Symmetry

and Motif 

‘Non-Hydrogen Bond’
Intermolecular

Interactions

We can mine the CSD to identify 
these intra and intermolecular 

geometric preferences.



CSD-Core – Conformations

• Mogul provides precise information on 
preferred molecular geometries 

• Validate molecular geometries rapidly 
using interactive plots & statistics

• Identify any unusual features of a given 
query structure

• Mine millions of chemically classified 
bond lengths, angles, torsion angles and 
ring conformations in the CSD

Bruno et al., J. Chem. Inf. Comput. Sci., 44, 2133-2144, 2004



CSD FINWEE10
PDB FK5 

Using Mogul to check new structural data

I.J.Bruno, G.P.Shields, R.Taylor, Acta Cryst. (2011). B67, 333-349 DOI: 10.1107/S0108768111024608

Protein 
ligands

Small 
molecules

Theoretical 
data



About you

What would you like to analyse using Mogul?
• CSD/published structures
• Your own experimental structures
• Theoretical structures
• Protein ligands
• Other



Mogul – Launch from Mercury



Mogul Geometry Check



Mogul Geometry Check - Results

Colour code:
• Blue: It is a not unusual value in 

the CSD and there are enough 
data in the CSD for comparison.

• Pink: It is a not unusual value in 
the CSD, but there are only few 
data in the CSD for comparison.

• Orange: It is an unusual value 
in the CSD and there are 
enough data in the CSD for 
comparison.

• Brown: It is an unusual value in 
the CSD, but there are only few 
data in the CSD for comparison.

Double click 
on a row to 

view result in 
Mogul



Value           
in your 
structure

Histogram 
built with 
data from 

structures in 
the CSD 

Colour 
coded 
by data 
update

Statistics

Results and 
filters

Cluster only 
available for 

rings

Mogul Geometry Check - Results

Click bars or bins to 
deselect hits

Click and drag to 
deselect a range



Mogul Geometry Check – View structures

Fragment 
shown

Click through hits

Measurement 
given

Click through 
the refcode list

Number of 
structures



Example of a Mogul Geometry Check
We will:
• Run a Mogul Geometry Check from Mercury.
• Visualise and analyse the results.

Follow along Mogul Demo

COBFIK



Agenda

• Introduction to the CSD
• Visualizing structures in the CSD

• Slides and follow-along demo

• Analysing the geometry of structures using Mogul
• Slides and follow-on along demo

• Analysing intermolecular interactions using FIMs
• Wrap up, quiz and summary 



CSD-Materials overview

Motif Search & 
Packing Feature Search CSD Conformer

Generator

Full Interaction Maps

2 Donors
2 Acceptors

Hydrogen Bond Propensity

Hydrate Analyser & 
Solvate Analyser

Crystal Packing
Similarity

Aromatics Analyser Molecular
Complementarity

Detailed Structural Analysis Solid Form Design

Solid Form Risk Assessment



Full Interaction Maps (FIMs)

• Map interaction preferences 
around complete molecules in 
a crystal structure.

• Visualise observed atom-atom 
contacts with respect to likely 
geometries in 3D space.

• Identify interaction hot-spots 
around chemical groups.

hydrogen-bond 
donor

hydrogen-bond 
acceptor

hydrophobic 
interactions



Understanding intermolecular interactions
central group: -CONH2

contact group: NH

Search for structures containing desired contact

Superimpose hits and display as scatterplots or contour 
plots



Combining plots into Full Interaction Maps

P. A. Wood et al., CrystEngComm (2013), 15, 65–72

• Molecule is broken down into fragments

• IsoStar maps for each fragment are combined to give the Full Interaction Map



Predicting intermolecular interaction geometries

• “Early development candidate”

• Two polymorphs, metastable (a) 
and stable (b)

• Packing arrangement of stable 
form (b) satisfies Full Interaction 
Map particularly well

• Packing arrangement of (a) 
does not

N. Feeder et al., J. Pharm. Pharmacol. (2015), 67(6), 857-868



Creating a FIM
FIMs enable you to  

generate a 3D 
interaction map 

around a molecule 
representing 

regions of higher 
probability to find 
interactions with 
certain functional 

groups

More info available 
in our blog and 

video

https://www.ccdc.cam.ac.uk/Community/blog/getting-started-with-FIMS/



Agenda

• Introduction to the CSD

• Visualizing structures in the CSD
• Slides and follow-along demo

• Analysing the geometry of structures using Mogul
• Slides and follow-on along demo

• Analysing intermolecular interactions using FIMs

• Wrap up, quiz and summary 



Explore More: Quiz

How to play!
• The questions will appear on the slide: pick and 

note down your answer within the time given!
• We will reveal and present the answer.
• Note down your score: one point for every right 

answer and zero for any wrong answer or not 
answered question. 

Hint: keep Mercury and Mogul open alongside 
your notes from today.



1. When opening your own file in Mercury, how 
can you make sure that bond types, missing 
hydrogens and aromatic rings will be displayed?

B. After loading the structure, 
go to Edit > Auto Edit 
Structure, tick the desired 
option on the menu and click 
Apply.

A. Before loading the structure, 
go to File and tick Auto Edit 
Structure on Load, then load 
your structure and it will be 
automatically edited.

D. All the options are correct.B. After loading the structure, 
go to Edit > Edit Structure, 
and manually apply the edits 
to bonds and hydrogens.



2. From which menu can you access Mogul 
Geometry Check in Mercury?

B. CSD-MaterialsA. CSD-Core

C. CSD-Discovery D. All of the above



3. FIMs are built on the knowledge from the 
structures in the CSD, harnessed using another 
tool of the CSD Software: which one?

B. HermesA. Mogul

C. Isostar D. None of the above



How many points did you get?



What have we learnt?

• How to visualise and explore over a million crystal structures
• What the Cambridge Structural Database is and how it can be used in your research
• How to visualise structures using Mercury
• How to explore the packing, symmetry and hydrogen bonded networks of structures

• How to analyse the geometries of structures using Mogul 
• Familiarity with the basics of Mogul
• How to get more insights into your crystal structures and interpret results obtained from 

Mogul
• How to use Mogul for CSD structures and new structure determinations

• How to analyse the interactions within a crystal structure
• Knowledge of how Full Interaction Maps are generated and how to create them
• How to interpret results obtained from FIMs
• Why looking at interactions are important and how FIMs can be used in your research

• The value of using structural data in your research



Want to explore more? 

Self-guided workshops

YouTube and 
LabTube
channels

Register for 
E&O newsletter

On-demand 
modules with 

completion 
certificate

https://www.ccdc.cam.ac.uk/Community/educationalresources/

https://www.ccdc.cam.ac.uk/Community/educationalresources/


CSDU

• On-demand modules to 
learn how to use the CSD 
Software at your own pace.

• Completion certificate after 
a final quiz!

https://www.ccdc.cam.ac.uk/Community/educationalresources/CSDU/

U U U



Videos highlights

• How-to: Create and share 
personalised styles in Mercury

• How-to: Labels in Mercury

The video names are links to the videos.

• How-to: Basics of hydrogen 
bonds in Mercury

• Introduction to symmetry 
operators and point groups

https://www.youtube.com/watch?v=-JPYCbMqhfE
https://www.youtube.com/watch?v=FvKgc42Xik0
https://www.youtube.com/watch?v=bd8k0grYid8
https://www.youtube.com/watch?v=BE8yQyA9RUc


CIF resources you might find useful

https://www.ccdc.cam.ac.uk/Community/educationalresources/
database-of-educational-crystallographic-online-
resources/resources-by-topic/CIF/

Resources 
by Topic

Slides and web material 
to learn about CIFs. 

Materials on crystallography (slides, videos, web
pages, exercises, documents, …) from lecturers in
the communities shared publicly for other
educators to use in their lectures and for
students to practice, review, and explore new
concepts.

https://www.ccdc.cam.ac.uk/Community/educationalresources/database-of-educational-crystallographic-online-resources/resources-by-topic/CIF/


Access the CSD Data and Software

Until 31st July 2022

• You can explore CSD 
functionality using the 
workshop license!

After 31st July

• If you wish to continue access at 
the end of the workshop license 
period, your institution probably 
already has access to the CSD. 

• If your institution does not have a 
license or you do not manage to 
find the license contact, you can 
get in touch with 
admin@ccdc.cam.ac.uk, and they 
will be able to advise you.

mailto:admin@ccdc.cam.ac.uk


Documentation

CCDC website

How does this 
functionality work? How 
are the results obtained?

https://www.ccdc.cam.ac.uk/support-and-resources/ccdcresources/



Display contacts visualisation options in 
Mercury

1. Set 
contacts style 
to sticks.



Display contacts visualisation options in 
Mercury

2. Change the 
thickness to 
change the 
number of 
segments 
you see in the 
contact line.

0.1

0.16
0.26



Display contacts visualisation options in 
Mercury



Label chiral molecules



Chirality in the CSD Python API

https://downloads.ccdc.cam.ac.uk/documentation/API/



Working at the CCDC

• You can see our 
open positions…

• … or send us an open 
application


